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Welcome back... Having completed our exclusive For Beginners

digital guidebook,we have taught you all you need to master the

basics of your new device, software or hobby.

em

Advancing your skill set is the goal of all users of consumer

technology and our team of long term industry expertswill help you
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looking in greater depth at how you make the absolutemost from

the latest consumer electronics, software, hobbies and trends!

Wewill guide you step-by-step through using all the advanced

aspects of the technology that you may have been previously

apprehensive at attempting. Let our expert guide help you build your

understanding of technology and gain the skills to take you from a

confident user to an experienced expert.

Over the page ourjourney continues, and we will be
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inspire you to go further.
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YOUR GUIDE TO IMAGE EDITING

A Guide to
Using Layers
Layers are one of the fundamental aspects you can employ when it
comes to non-destructive image editing.

very core of image editing since its
introduction in the early '90s. As

you might imagine, layers are exactly
what they sound like. You can have a
number of separate elements, each
on its own layer, that are stacked one
on top of the other. When all viewed
together, they create the final imag.
The advantage of using layers is clear.

It means you can change an element
on one layer only and not have an
impact on the rest of the image. It also
means that you can take an image
and duplicate it on another layer and
perform any edits you want on that one
in the knowledge that the base image

T<
use of layers has become the will remain untouched in case it doesn’t

turn out quite as you had hoped. Within
Elements, there are four main types of
layer. There is the basic pixel layer which
contains the main photo elements of the
project. There are text layers where you
can type text and change the size and
colour. Then there are fill/adjustment
layers that are designed to affect the
layer below it such as changing the
saturation or brightness of the layer
below, or just adding a colour to that
layer. Finally there are vector layers that
contain scalable graphical elements such
as shapes and work paths. Each layer
type can also have a mask added to it so
only part of that layer can be seen.

0 Create New Layer
You can click the Create New Layer
button at the top of the layer panel, use
the key broad shortcut or go to the file
menu and choose Layer > New > Layer
to add a new layer to the stack. You will
be prompted to name the new layer. You
can rename it at any time.

3 Create New Group
Sometimes it may be necessary to take
a number of layers and group them
to make things more manageable, as
the number of layers increases in your
document. You can highlight each layer

pene
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you want and then press the Create
New Group button to group them.
Alternatively, you can go to the file menu
and select Layer > New > Group

°o Fill or Adjustment Layer
Fills and Adjustments allows you to add
colours, gradients and patterns to a layer.
They also allow you to add adjustments
such as Brightness and Contrast, Hue and
Saturation and Levels. Adjustment layers
affect the layers directly beneath them in
the stack or they can be clipped to the
one layer directly below them only.

oO Add Layer Mask

Each layer you use in a document can
have a layer mask added to it. The mask
is designed to let you hide or reveal

specific parts of that layer only. Areas
of the mask in white let the layer remain
visible, while any areas of the mask in
black hide that part of the layer. The
rule of thumb is: white reveals pixels and
black conceals them.

6 Lock all Pixels

Clicking this button locks the layer
completely and no further edits can be
made to it. You will also be unable to
reposition the image on a locked layer.

Lock Transparent Pixels

If you click this button, any area of a
layer that has no image pixels in it is
considered transparent. An area that is

transparent is then locked and no edits
can be made so it remains transparent.

Share +Create +

Ll a! ® @ 0 710:
Opacity: 100%|
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A GUIDE TO USING LAYERS

Delete Layer
The trashcan shaped button lets you
delete any selected layers if you wish to
remove them from the layer stack.

© Panel Options
There are of menu options
available here such as Rename Layer,
Duplicate Layer, Delete Layer, Link
Layers, Merge Visible and Merge Down.

© Blend Modes

Blend Modes determine how the image
colours on the layer interact with the
layer below it. It can be changed for
every layer individually or as part of a
group for certain visual effects.

© Visibility
The small eye icon on the left of each
layer lets you turn that layer off so it is
not visible. Any effects associated with
that layer are also rendered invisible until
the eye icon is clicked once more.

@ Link/Unlink Layers
This lets you link a number of layers
so that any transformations and move
commands you make are all applied to
the linked layers at the same time.

© Background
The Background layer is the default
bottom layer. Whether it is an image
you have opened or a new document,
the Background layer is always partially
locked until you choose to unlock it.

® Standard Layer
A typical layer with pixel information
displayed on it.

®@ Adjustment Layer
An adjustment layer is designed to affect
the layer below it. In this example, we
have a Levels adjustment that alters the
brightness and contrast of all the layers
stacked below it.

© Vector Layer
A vector layer contains scalable data
such as shapes in the case of our
example. A small icon in the lower right
corner of the thumbnail indicates it is a
scalable graphic.

© Text Layer
The thumbnail of a Text layer displays a
T to indicate the layer contains scalable
text. The layer name also reflects
whatever text is on that layer.

ber
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YOUR GUIDE TO IMAGE EDITING

Methods for
Aqdjusting an Image
When it comes to methods for adjusting your images in Elements, you
are spoilt for choice. There are a number of methods to get an image
looking great. We'll show you how each one works, with some examples,
to help you choose which method suits you best.

Quick Mode

We start in the Quick mode workspace with a sunrise To remove such a blemish, you can go to the toolbar and
image of a pier that is in need of some work to make it choose the Spot Healing Brush Tool (J). When you choose

look its best. The first thing to do is remove that large black spot this tool, the Tool Option panel displays Spot Healing Brush
in the top right corner: probably a bit of rmud stuck to the lens, options. You can choose Spot Healing Brush or Healing Brush to
currently spoiling the shot. remove the spot.

The main difference between the two brushes is that the The Healing Brush Tool asks you to select an area to be
Spot Healing Brush lets you paint directly over the blemish the clone source by clicking on a clean part of the image

and then works out what to fill it with by analysing the area next to the blemish. This chosen area will then be cloned over
around it. Proximity Match and Content Aware are the best the blemish when you paint over it. The cloned source will be
options here for this kind of blemish. blended in to be as seamless as possible.

i E!

CSpot Healing Brush Tool {J)

Spot Healing Brush

:
Type: © Proximity Match

:
Brush: ~

Size:

(J Sample All Layers

(Create
Tex

Spot Healing Brush Tool (J)
el

Photo Bin : Tool Options: Undo Redo Rotate Organizer Home Screen

Healing Brush

Size: 90 px Source: Sa

Brush Settings... :
Mode: Nd

Healing Brush Tool (J) :

3 TJ Aligned : c

C =
Photo Bin ‘Tool Options: Undo Redo Rotate Organizer Home Screen



6 You can alter the brush size by using the Size slider in
the Tool Options panel or by pressing the left and right

bracket keys. Pressing [ will reduce the size of the brush and
pressing ] will increase the brush size. This lets you clone with
greater accuracy and detail if you need it.

METHODS FOR ADJUSTING AN IMAGE

6 Now that the blemish is gone, we can look at making
the image more vibrant and appealing. Layers are not

available in Quick mode, so it comes down to choosing the
right method for the best overall effect. The easiest way to see
the effect you can have on the image is to choose Adjustments
from the taskbar.

This calls up the Adjustments panel. You can choose
Smart Fix and select from a number of options that make

subtle changes to the image and recover detail in the highlights
and shadows. Hover over each one to see a preview of the
effect applied to your photo. Click the one you want to apply.

Next, you can go to the Exposure adjustment and
choose to make the image brighter or darker. Again you

can hover over a number of options and see a preview of the
effect or use the slider to make more subtle adjustments to the
brightness of the image.

The Lighting panel is the key to really controlling the
brightness of your Highlights, Midtones and Shadows,

each of which has its own tab for you to access. Choose from
the options provided or use the sliders for more subtle control
of each of the tonal options.

The vividness of your image can be controlled in the
Colour panel. Increase the Saturation globally or use

Vibrance to increase the most subdued colours first. Hue lets
you shift the entire colour palette for a surreal colour effect if
you require it.

f
Aqjustments Effe

—_—O—— 1 Adjustments

Smart Fix Exposure
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YOUR GUIDE TO IMAGE EDITING

@ Balance lets you shift the colour temperature from cold
to warm and Tint allows you to add either an increasingly

green colour cast or a magenta cast to help offset any colour
inconsistency in your original image.

Quick Mode

it Image Enhance Layer Select Filter View Window Help

Auto Smart Fix ae 3")

eae
Auto Levels
Auto Contrast
Auto Haze Removal ae 2.)

Aute Celer Cerrection Bird)
Auto Shake Reduction
Auto Sharpen
Auto Red Eye Fix

Adjust Color

Adjust Lighting
Adjust Smart Fix...
Convert to Black and White...
Haze Removal...

Under the Enhance menu are a number of Auto features to
improve your image. These are quite broad in their effect

and do lack a certain finesse, so you have no real control over the
outcome. If you want some more input in the effect there are a
couple with a bit more contro! worth looking at.

ato

© Finally, you can go to the Sharpen panel and apply levels of
sharpness to your image; but beware of overdoing it and

creating artefacts and halos as the contrast increases and bright
unwanted highlights appear around areas of high contrast in your
photo. If you are happy, you can save the result.

If you go to Enhance > Auto Smart Tone (Shift + Crnd + T)
an interactive panel appears, where you can drag a cursor

around a grid. Each corner of the grid shows a possible outcome
that can be achieved by moving the cursor further in that
direction. Move it around until you get the result you want.

If you go to Enhance > Adjust Colour > Adjust Colour
Curves, you can adjust the Highlights, Midtones and

Shadows of your image. There are a number of preset styles you
can choose from to enhance the colour in your image as well as
the option to manually adjust the tone sliders.

Another option, but one that needs a light touch, is the
Haze Removal tool. Go to Enhance > Haze Removal (Shift +

Cmd + Z). This can be quite a strong effect but there are sliders
to adjust the strength of the Haze reduction applied and also the
sensitivity of the haze detection.

Balance
Sharpen

Tint

Cc 0
1

EE

Sharpen

‘Adwist Coior Curves



METHODS FOR ADJUSTING AN IMAGE

Guided Mode

Guided Mode is an alternative if you are happy to have less
advanced adjustment options available but with more step-

by-step guidance to help you on your way to creating the final
image. Make sure you have an image open in the Photo Bin ready
to work on.

You will be asked to create a Levels adjustment and a
dialog panel will appear. Click OK. Since the image has a

lot of underexposed dark areas in the foreground, sliding the
Midtone slider to the left will brighten the photo in those darker
areas. You can then click Next and then Done for this part.

36 The great thing with Guided edits is that you don’t have to
apply just one edit. We are going to apply several to get

the end result we are after. Start with Levels to get the overall
brightness of the image dialled in first. Levels can be found in the
Basic category.

Now, if you look in the Photo Bin, back at the main Guided
Home screen, the photo will have a small icon in its top

right corner that indicates it has edits applied. Then, you can go
to the Colour category and choose Enhance Colours to add more
vividness to the photo.

You can use the three sliders of Hue, Saturation and
Lightness to make the image much more saturated and

bring out the colours in the sea, sky and foreground. A boost of
Saturation to 45 and Lightness to -2 is enough to bring more life
into the photo. You can lick Next and Done once more.

Finally, back in the Basics category, click Lighten and Darken
and use the three Shadows, Highlights and Midtones sliders

to make final tweaks to the image. The Highlights have been
reduced to bring more detail back into the brightest areas. At this
point you can click Next and then save your image.

Show Open Files +

Phote Bin : Tool Options: Undo Reda Rotate Organize

Adjust the brightness, contrast, and tonal

range of your photo.
laut pert

1, Click Create Levels Adjustment to open
the Levels dialog box.

CreateLevels Adjustment

2. To ensure that your image uses the full

range of tonal values, drag the black slider

to the right so that it is just below the left
most point of the graph. Then drag the
white stider to the left so that it is just
below the right most point of the graph.

Levels

© Learn more about: Levels

Channel: RGB +

Input Levels:

"i & &

Output Levels:

Show Open Files

(Ca),
Photo Bin ‘ Tool Options: Und

ENHANCE COLOR

Fine-tune and enhance the colors in y
photo.

Create ~ Share +

Zoom: 91% Enhance Colors

Click Auto to balance the colors and
contrast in the photo.

Auto Fix

Use the sliders below to fine tune the

adjustment.

Hue:

Saturation :

Create ~ Share ~

Lighten and Darken

Click Auto to applya general fix to the
Photo's exposure,

Ca) Auto Fix

Drag these sliders to manually balance the
shadows and bright spots.

Shadows:

Highights:

Midtones:



YOUR GUIDE TO IMAGE EDITING

Using the Photo
Editor Expert Mode
Don't be put off by the title of Expert. In this case, you get more tools to
play with and you can actually be more involved in the editing process.
You can switch out to another mode, but to truly unlock the power of the
program, you will want to try out some image editing in this mode.

We have opened another image that needs some fixing. It First, the colour balance needs to be adjusted. The image
is a sunrise on the moors that is a little underexposed and is a little too magenta and warm, particularly if you look

needs some work to bring out the foreground, while keeping the at the colour of the grass. This can be altered by using a really
sky relatively untouched, since that is quite well exposed. This is simple trick that can be really effective and requires the use of
where the use of layers and masks will help us out. layers to do it.

Press Cmd + J to copy the Background layer. Name the Make sure this layer is active then go to Filter >
new layer ‘remove cast’. Then go to Filter > Blur > Average. Adjustments > Invert (Cmd + |) to invert the muddy brown

This will blur the duplicate of the scene and average out the colour to a pale green hue instead. This colour, derived from
colours it contains into one colour. In this case, it turns a muddy the colour average of the original scene can be used to create a
brown colour. colour correction filter.

i CM

Normal + Opacity:

te

bot Filter View Window Help

Filter Gallery...

Correct Camera Distortion...

Adjustments

(Evie

slice)2)
Distort eVa lela

Gaussian Blur...
Tate

100%

Opacity: 100%) +Normal

Set the blending m de for th



USING THE PHOTO EDITOR EXPERT MODE

Go to the Blend Mode button and from the dropdown
CO

colour can be quite subjective and if you feel
menu that appears, choose Overlay as the biend mode for the correction is too much, you can always go to

the ‘remove cast’ layer. This will blend the colour of that layer into the Opacity slider and adjust to about 80% to lessen its effect
the photo of the moors below it. You should see that the snow slightly if you wish. Now you can continue editing the image.
now looks a lot cleaner and whiter than it did.

Now to make the image punchier, click the Create New Choose the Brush Tool (B) from the toolbar, then set the
Fill or Adjustment Layer button and choose Levels. Make foreground colour to black. You can press D to default

sure ‘Levels 1’ is at the top of the layer stack. Adjust the Midtone the colours so black is the foreground colour and white the
slider so the sky is a bit darker. This will obviously make the entire background colour. Pressing X will swap those foreground and
image too dark but you can fix that next. background colours over if you require.

Brush: |
~

Size;
10

ke
Rotate Layout Organizer Kome Scre

When you choose the Brush Tool, the Tool Options panel You can now use that soft black brush to paint on any areas
will display parameters for the brushes. We need a large of the mask where you do not want the adjustment to be

soft brush which can be chosen from the Brush Presets menu. visible. In this case, we only wanted the sky to be adjusted so we
Click on the Soft Round 200 pixels brush to make it active. Make painted over the rocks and foreground.
sure the Levels 1 layer mask is active by clicking it.

Color Dodge
Linear Dodge (Add)
Lighter Color

Hard Light
¥ivid Light

QGanao @ &
Overlay ~| Opacity:

Create

Channel: RGB

remove cast

a
0

Output Levels:

0

Background

DRAW

Brush Too! (B)

Set foreground color

|
Opacity:

Layer mask thumbnail
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When you paint over those areas, you are hiding the
adjustment so they become their original brightness again.

In fact, it would be nice to make the foreground rocks and snow
brighter, so let’s get another Levels Adjustment and add it to the
layer stack. This will be ‘Levels 2’.

© Just as you did with the ‘Levels 1' layer mask, paint with
your soft black brush on the ‘Levels 2’ layer mask over the

sky area and horizon. You are now concealing areas of the ‘Levels
2' adjustment so the sky goes back to being darker again.

Marmal =

& we .
|

Levels 2

eth
u

There is no reason you can't add the same amount of blur
to the ‘Levels 1' layer mask as well. The softening of the two

masks means there are no obvious joins betraying the fact that
various adjustments have been made. Thanks to the use of layers,
this has all been non-destructive editing.

© Push the Highlights and Midtones sliders of the ‘levels 2’
adjustment to the left; as you do this, you will see the entire

image become lighter. Concentrate on the foreground rocks and
snow and adjust the sliders until they look nice and bright. The
sky might be too bright but not to worry.

If you want, to blend the masks better, you can keep
the ‘Levels 2’ layer mask active and go to Filter > Blur >

Guassian Blur and choose a blur of about 125 pixels to help blend
the two adjustments you've made seem more seamless.

Now that you have both the Levels Adjustments in place,
you can revisit them at any time and tweak the settings to

your heart's content. You can even go back into the layer masks
for each and use your brush tools to refine those masks you
applied in the first place.

Levels 1

remove cast

Output Levels: remove cast

Background

UdQ-@a-

RGB

ula

|| Opacity:

Levels 1

remove cast

=

Gaussian Blur

on
Cancel

M Preview
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@ The image has now been colour balanced and two sets of
adjustments have brought some sparkle to the snow in the

foreground and kept the sky dramatic in the background while
the rocks now have some nice detail showing in them as well.

How much Saturation you add is a matter of personal taste
but to capture the glorious colours of that sunrise, it’s been

pushed to +36. You will notice however that the grass could do
with a little push to make it more vibrant.

USING THE PHOTO EDITOR EXPERT MODE

© Now let’s turn up the vividness of the image. Click on the
Create New Fill or Adjustment Layer button and choose

Hue/Saturation from the list that appears. A 'Hue/Saturation 1’

layer will be added to your existing layer stack. Make sure it is the
topmost layer.

Click the Channel button and you will see how you can
affect the saturation of the component colours. Select

Yellows and dial up the saturation and push the Hue slider to
about +23 to really bring out the vibrant green of the grass.

At this point, you may want to perform more edits to the
image. It is always good housekeeping to create a snapshot

of the work done thus far. To do this, press Shift + Alt + Cmd +E.
This creates a new layer which is a merged version of all visible
layers. Name this layer ‘merged’.

You can now perform edits directly to the pixel data of the
layer, safe in the knowledge that if anything goes

wrong, you still have all the original work on the layers below
which you can use to create another merged version. You can
also save your document as a PSD file when complete.

dam @-..
> Solid Color...

Normal Gradient...
Pattern...

Levels...

Brightness/Contrast...

Gradient Map...

@ 2 Photo Filter... 1

& yes
Invert L— Threshold...
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@
remove cast

Background

bemai
¥ Opacity: |100%| 7]
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@
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Hue/Saturation
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CD Colorize
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Selection
Tools
Some aspects of image editing will require you to select certain areas of
a photo so you can either place it on another layer or edit it in isolation
from the rest of the image. With Elements, you have a number of options
for being able to achieve this and we cover them next.

This tool lets you make selections of square or rectangular The Elliptical Marquee tool behaves in the same way as the
areas of your image. In addition to making the selection, Rectangular Marquee tool and has the same tool options

you can add to it, subtract from it and intersect with it. You can available. You can make circular and elliptical selections of any
make selections of a fixed size, fixed ratio or normal aspects. You size or proportion. If you hold the Alt key, you can centre your
can also feather and refine the edge. elliose over the cursor position.

The Lasso tool can be used to make area selections from This tool uses edge detection to adhere to the edge of the
your image or active layer. The shapes you select with the subject you are attempting to select in the image. You can

Lasso tool can be completely irregular and hand drawn. When alter its parameters for more accurate detection in order to make
you join the lasso back up to the point where you started, the it snap to the edge of your subject. Areas of high contrast work
selection is closed. best with this tool.



SELECTION TOOLS

Polygonal Lasso
—_

6 The Polygonal Lasso allows you to draw point-to-point The Quick Selection tool lets you paint a selection as if it
straight lines around your subject. This is good for were a brush. It uses edge detection to attempt to match

geometric and straight-edged subjects where a perfectly straight your selection to the nearest edge in the image. You can alter
line is required. Like the Lasso Tool, when you join back up with brush size and settings and it works best on high contrast
your start point, the selection is closed. subjects that are in sharp focus.

The Selection Brush is more of a freeform brush that lets This tool is useful for the selection of image areas that
you choose a brush type of certain size and hardness are the same colour and brightness. You can adjust its

and paint a selection around your chosen subject. You can also sensitivity, refine its edge and also choose whether it will globally
choose to make it a mask instead. You can add or subtract from select all areas of a chosen colour or just its nearest neighbours.
your selections in the usual fashion.

The Refine Selection Brush lets you make targeted This works in a similar way to Quick Selection except that
adjustments to an existing active selection. In additional to you use Rectangular and Elliptical Marquees and the Lasso

adding or subtracting from the selection you can actually push the and Polygonal shapes to enclose an area for edge detection to
selection edge and smooth it by applying the refinement brush. work within. It works best with well-defined shapes that have

good contrast.

Auto Selection
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Cloning, Healing
and Enhancing
Even with modern digital cameras, a lot of photos may have
imperfections in them; for instance with dust contamination. This will
be displayed as a black smudge on the final photo. Removing these
blemishes is quite easy. The technology can also do much more.

Eye Tool

Red-eye is caused by light from the flash of a camera Click the Eye Tool CY) and simply click your cursor over the
reflecting off the blood vessels at the back of the eye when offending redness in the eyes of your subject. The tool will

the pupil is wide open. If you happen to find a favourite photo remove the redness and you can alter Pupil Radius and Darken
where your subject has red-eye, then it is a simple process to values to make sure the red has been completely removed. It can
remove it. also be set for Pet Eye as well.

Closed Eye Correction

Another great function available in the options panel is the Eyes that closely resembie your subject will work best or if
function to open closed eyes. Click the Open Closed Eyes you have another image where the eyes are open, you can

button to activate the dialog. The image will scan for closed eyes load that and the program will automatically apply those open
and circle possible candidates. Choose the one you want. You eyes to your current image.
can then choose a set of open eyes to merge into the shot.

Click to Apply:

Click to Apply:

dA ‘ee



Spot Healing Brush Tool

The Spot Healing Brush is great at removing dust spots
from photos and is also great for removing spots from

humans too. If you have a portrait and the subject has some
unwanted blemishes, you can use the Spot Healing Brush to click
on the spot and it will use nearby pixels to fill the area.

CLONING, HEALING AND ENHANCING

0 You can choose between Proximity match, Create Texture
and Content Aware. For most of your subjects, you may

find that you are switching between Proximity Match and
Content Aware. You can adjust the brush size for smaller spots.
With care, most blemishes and wrinkles can be removed easily.

The Healing Brush is an older version of the Spot Healing
Brush. It requires you to specify a sample point of a similar

clean texture which is then cloned over your chosen area much
like a Clone stamp when you click on the target blemish or
wrinkle you wish to remove.

Smart Brush

The Smart Brush uses edge-detection to allow you to brush
areas of your photo and apply different effects to those

areas. When you select the Smart Brush Tool (F) the options
panel has an effects picker to let you choose which effect you
want to apply to your photo.

When it comes to Healing Brush techniques, you will find
that subtiety is the key. Spot Healing is not perfect and may

require several attempts to get it right. Avoiding too many repeat
patterns is important to avoid creating a texture that doesn't look
like it has been cloned.

Choose an effect such as a pencil sketch effect and begin
to drag your brush over the image, where you want the

effect to be seen. You can change brush size and settings such as
hardness and roundness and subtract from the current selection.
Choose the Detail Smart Brush for more refined selections.
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YOUR GUIDE TO IMAGE EDITING

Clone Stamp Tool

After the Healing Brush Tool, the Clone Stamp Tool (S)
will seem quite familiar. It copies pixels from one area onto

another to remove things from your photos. Despite recent
advances with the Content Aware and Spot Healing Tools, it
remains one of the best ways to remove things from a photo.

Here is a wildlife photo from which we want to remove the
distracting blades of grass that are sticking up to the right

of the rabbit. This is a good example of how cloning can quickly
remove elements from your photos with minimal effort.

Select the Clone Stamp Tool (S). In the options panel, you
will have a number of paramaters to choose from such as

Size, Opacity and Blend Mode. The Aligned button, when ticked,
links to and moves your source point as you move your cursor.
Unticked, it uses the same source point each time.

Press the Alt key and select an area right next to the tip
of the grass as the source of your cloned pixels. Now you

can clone that area over the blades of grass. If the colours don’t
match, you can reselect an area that more closely matches and
doesn't stand out as cloned.

Work you way down the grass stem, you can change the
size of the brush at any point by pressing the left and right

bracket keys on your keyboard. Take your time and don't be
afraid to keep selecting new clone source points so the colours
match the background when you clone out more of the grass.

One thing that really gives cloning away is a repeating
pattern. If you see a pattern building up, you can press

undo (Cmd + Z) to step backward though your last performed
actions and change your clone source again to avoid the
repetition of that pattern.
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In the options panel, you also have the Pattern Stamp You can change the Pattern Stamp’s Size and Opacity as
available. As the name suggests, you can use this tool to well as the Blend Mode. Choosing Soft Light, for instance,

apply a preset pattern to your image. Click on the pattern picker allow a softer blend of the pattern into the image. Click
and choose the pattern you want to apply to your photo. Impressionist to turn the patterns into paint dabs for a more

artistic effect.

Blur, Sharpen and Smudge

The Blur Tool (R) is a fairly self-explanatory tool for adding The Sharpen Tool (R) uses a brush tool to apply sharpening
blur to specific areas of a photo. You can choose a brush to your image. Like the Blur Tool, it is a more targeted

type and alter its Size and Strength values for a subtle or intense method of adding sharpness to a photo. Choose your brush type
blurring of your subject. and alter the Size and Strength values to get the desired effect.

Approach sharpening with caution since it is very easy to The Smudge Tool (R) can be used to smear the pixels of
overdo it and ruin an image with over sharpening. Make your photo across the screen for a creative effect. Just

sure the Protect Detail button is ticked and begin to apply the like Sharpen and Blur, you can alter the brush type and set the
sharpening effect. Size and Strength of the effect. The Finger Painting button adds

colour to the smudged pixels.
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The Sponge Tool (OC) has two Mode settings of Saturate It's a simple tool for adding targeted saturation or
and Desaturate. You can control the Size settings as well as desaturation to the photo. It is recommended to set the

the Flow of the effect you are adding to your image. You can also Flow of these brushes to about 10%. Then gradually build up the
set the type of brush you want to use to apply the effect. application of colour saturation, the removal of colour entirely or

just lessen the vibrance of areas in the photo.

Click and drag the Sponge Tool over the areas you The Dodge and Burn Tools are named after the
selectively wish to Saturate or Desaturate. Continue to techniques that were originally used in traditional film

brush the areas to increase the amount of the effect you are processing darkrooms. Dodging refers to selectively making
applying. In this example, brushing using the Desaturate option areas lighter in an image and Burning is the opposite effect of
eventually turns the affected areas to grey. making images darker.
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CLONING, HEALING AND ENHANCING

Or Dodge Tool can be used to lighten images. Use theOre button to determine if you are affecting just the Qo can selectively brighten areas of the image that you
to make lighter. These tools work better forimages

Highlights, Midtones or Shadosin your photo for greater that start with lower amounts of contrast to begin with. High
control of the final result. Again, using very low Exposure settings contrast images will have less need for these kinds of adjustments.
around 10% is recornmended.

The Burn Tool will selectively make parts of your photo Now you can brush over areas that you want to be darker
darker. You can darken the Highlights, Midtones and and create more contrast. Since this particular method is

Shadows by clicking the Range button again and adjusting a destructive one, in that you are altering pixels, duplicating the
the Size and Exposure settings of the brush. Subtlety is key to base layer and working on a copy is a good way to avoid losing
making it work, so Exposure settings of 10% are a good start. the original.
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YOUR GUIDE TO IMAGE EDITING

Draw, Fill,
Shapes and Text
The Draw section of the toolbar contains various elements to let you
paint, draw, erase and sample colours in your images. There are also a
number of text options available for adding text effects to your photos
and making masks in the shape of any text that you type.

Brush Tool

—

The Brush Tool (B) is one of the most often used tools When you click on the Brush Tool, the options available are
in the photo editor's arsenal. Whether you are painting quite varied. You can control brushes with your mouse or if

directly over a photo, or adding brush strokes to a layer, the you use a tablet, you can control it as if it were an airbrush with
Brush Tool is designed to behave like its real world counterpart pressure sensitive effects for more artistic flair.
but with more powerful features built in.

You can choose any number of brush types from the brush You can choose the colours you brush with and also use
picker and alter the Size and Opacity values. You can also the Brush Settings sliders to change how much the colours

load new brushes that can be purchased and downloaded from a fade and alter with each brush stroke. You can also tell the brush
large number of vendors specialising in photo editing tools. how much Scatter or Spacing to use with each brush stroke you

apply. Tablet settings are also available.
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DRAW, FILL, SHAPES AND TEXT

6 Next to the standard brush is the Impressionist Brush Tool When you paint with this brush, the image beneath the
(B). Using its various Brush Settings you can turn your cursor is turned into a series of loose curls, swirls and

photo into a painting much in the style of the old impressionist daubs. The larger the brush size you use, the more abstract the
painters whose works were rendered as a series of dots, strokes image becomes. Using a brush that is too large will render the
and swirls. photo unrecognisable.

The next brush is the Colour Replacement Tool (B). Select a Our example picture is of an owl set against a green
foreground colour in the toolbar to use as the replacement background. The colour of the background can be replaced

colour. Once again, you have a number of tool options available fairly easily since the owl itself contains no strong green colours
including Size, Tolerance and Limits. that match the background too closely.

The Colour Replacement Tool works by continuously In the case of the owl image, dragging the Colour
sampling the colour directly under the cursor position. The Replacement Tool over the green areas next to the owl

colour beneath the cursor will then be replaced with whatever replaces that colour; but the owl remains untouched since it is not
you have chosen as the foreground colour. You can select the the same colour as the colour beneath the crosshair of the tool.
Blend Mode used to effect how the replacement colour is applied.
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Eraser Tool

Much like its real world counterpart, the Eraser Tool (E)
removes pixels from your image. Whatever colour you have

chosen as the background will be used to erase pixel data from
the photo as if it were a solid coloured brush. You can also set
the Size and Opacity of the eraser.

3 If the photo is on a layer, then erasing pixels will reveal
transparent areas instead. Again, if you alter the Size and

Opacity of the Eraser Tool, those transparent areas can either
be fully transparent or partially transparent, depending on brush
opacity settings.

The Background Eraser Tool (E) is a useful one for targeted
removal of certain parts of an image. It behavesa little like

the Colour Replacement Tool but in this case, any pixel colour
beneath the cursor is erased, leaving the area transparent when
it’s on a layer.

You can alter the Size and Tolerance of the brush, as well as
the softness and spacing of the brush you use. Tolerance

is key to setting the sensitivity of the brush to changes in colour.
High Tolerance will mean more varied colours are removed under
the cursor position.

In our example, the blue can be removed sky from the
photo by placing the cursor over the blue areas to be

removed. As you click and drag the mouse, any blue that falls
under the cursor position will be removed, but the white clouds
remain untouched since they are not blue.

The Magic Eraser (E) is a more global erasing tool. Set your
Tolerance higher for more colours to be included or lower

to pick out less shades of the target colour at the cursor position.
When you click on the blue sky, large swathes of that colour will
be removed with each click of the mouse.

Brush: eee : © Pencil

: © Brush
Size: 250 px

Block: joc:
‘ Opacity: 100%

Dm es F

Doc: 6.45M/6.45M

Background Eraser

9 fy),
Background Eraser Tool (E)

Size:

y Tolerance:

150 px

14%

Brush Settings...

Limits: © Con

ODis¢

> Cc &

Hardness:

Spacing: 75%,

100%

OffSize:

Tolerance: Off



The Paint Bucket Tool (K) allows you to fill areas with solid
colours. You can set Opacity, Tolerance and Blend Mode.

High or low Tolerance settings mean it will use edge detection to
decide which areas can be filled or ignored.

DRAW, FILL, SHAPES AND TEXT

Paint Bucket Tool

6 You can fill and entire layer, or it can be used to fill specific
areas based on what edges it encounters. Our example

has a cartoon character on a white background. His outline is
quite well-defined so clicking with the paint bucket means the
background can easily be filled with a colour.

You will notice there is an option for Contiguous fill. If it is

ticked, only the nearest neighbouring colours will be filled. If
the Contiguous button is unchecked, then all matching colours in
the image will be filled, no matter where they are in the photo.

Gradient Tool

The Gradient Tool (G) lets you fill areas of your image or
entire layers with colours that fade from one to another or

can fade from one colour to transparent. The Gradient Tool does
not use edge detection. If you need a filled shape, it needs to be
defined by a selection.

In addition to the Paint Bucket, you aiso have the Pattern
Fill option. Once again you have Tolerance settings and

Opacity values to alter. Choose a pattern and use that to fill an
entire layer or in the case of our cartoon, the blank background
can be filled with texture.

You can pick the kind of gradient you want to use by
clicking on the Gradient Picker and choosing a preset from

the list. They range from Foreground to Transparent to multiple
colour gradients all at the click of a button.
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YOUR GUIDE TO IMAGE EDITING

6 If you want to make your own gradient, you can click on Our example of a camera on a white background could
the Gradient Editor and add what are known as Colour use some colour. The background has an active selection

Stops to a basic gradient, change their colour and define if they around it to enclose the gradient when it is added. You can click
are solid or transparent. Any custom made gradients can be and drag your cursor to draw out a start point and an end point
saved as a preset. for the gradient to follow.

When you let go of your mouse, the current gradient will If required, you can change the type of gradient you are
be applied and fills the active selection around the camera. using from its default. You can also use Radial gradients,

The default Gradient Type is linear, meaning that the gradient Angle, Reflected and Diamond gradients. They can all have their
travels in a straight path from start colour to end colour. Blend Mode altered as well as Opacity. They can be reversed and

Transparency and Dither turned off.

Colour Picker

The Colour Picker (1) does as the name suggests. When you You can choose whether it samples a single pixel or a 3 x
choose this tool, it gives you a small eyedropper cursor that 3 average or a 5 x 5 pixel area to create an average. The

when clicked on a photo, picks the colour beneath the cursor colour it samples can be across all layers or a single layer.
position and makes it the active foreground colour.
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DRAW, FILL, SHAPES AND TEXT

Custom Shape Tool

Choose from a number of predefined shapes and add them Once you have chosen your settings, you can draw out
as vector shapes on a new layer. Choose their colour and the shape on your photo. You can click and drag from the

Layer Style from the Style picker. You can also choose whether corner outwards or choose From Centre to draw the shape out
they are of fixed size or unconstrained and if you add to a shape from the cursor position. The shape will fill with your chosen
or subtract from it. colour when you let the mouse button go.

Horizontal Type Tool

The Horizontal Type Tool (T) gives you a multitude of text You also have vertical text options, text for masking and
options. Choose your font, its colour and size. You can then the ability to fit typed text to a shape or path. Our example

type on your document and a new text layer will be added above shows a butterfly's outline with sample text following the outline
your photo. The text can be manipulated and bent into a curve or of that shape.
other shapes for creative effects.

Pencil Tool

The Pencil Tool (N) is designed to act like a real world pencil You are then free to use your mouse or tablet, to sketch and
and is a hard-edged tool that has a number of preset pencil draw with your pencil as you see fit. You can draw directly

tip shapes to draw with. You can choose the Size, Opacity and over your existing image or create a new layer and draw on that
Blend Mode for your pencil strokes along with its colour. so as to preserve your original image.
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Modity, Croo, Move
and Recompose
The Modify section of the toolbar contains a set of tools that give you the
ability to crop in a number of ways and to scale your images but protect
certain parts from being affected during the scale. You can also move the
subject of your photo from one part of the scene to another.

Crop Tool

The Crop Tool (C) is the most common method of cutting You can use set proportions to crop or you can go it alone
areas of your photo off in order to change the composition with no restrictions and make your own crop. Simply click

and proportions. When you click the tool, the options panel will and drag your mouse across the area of the scene that you want
display some suggestions for you as to how it thinks the image to be cropped and a gridded box will show you the current crop.
can be cropped. You can use those or make your own crop. You can click the green commit arrow to proceed.

Within the crop tool options you also have the Cookie With your shape chosen, you can drag it over your image
Cutter Tool (C), which lets you cut out images using a and scale it to cover the area of the photo you want to

number of preset shapes. You can choose from all the available crop. If you tick the From Centre button in the optional panel, the
shapes such as butterflies, snowflakes, graphic symbols and shape will be drawn outward from your cursor position. You have
much more. the option to feather the crop if you want.
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MODIFY, CROP AND RECOMPOSE

6 If you hold the Shift key as you drag, you can keep the © The Perspective Crop Tool (C) lets you draw a crop box
shape’s proportions locked. When you let go of the mouse, around a specific part of your photo that is distorted and

the image will be cropped in your chosen shape. You then have gives you a chance to crop and remove the distortion at the
options available that let you Rotate, Scale and Skew the shape same time. You start by drawing a crop box around the area you
until you have it how you want it. want to crop.

You can then begin to manipulate the crop box to match When you click on the green commit button shaped like a
the perspective of the object you are cropping. Use the tick, the Perspective Crop Tool will crop and stretch out the

control points around the crop box to drag the box out to match image, removing the distortion. It may take a couple of attempts
the subject. In our example, the road sign gives us some helpful but it can help you rescue some tricky, distorted images.
straight lines to match the perspective.

Recompose Tool

The Recompose Tool (W) uses content aware scaling Here is an example of a rally car with a lot of empty space
technology to let you scale images to a different to the right. It could be cropped but this image provides

proportion, but only scale areas with no detail. You can also a good excuse to try the Recompose Tool. The options panel
select areas to remain untouched by the scaling process for a displays a number of tools to help you with the scaling process.
much better final result.
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YOUR GUIDE TO IMAGE EDITING

6 You can use the Mark For Protection brush to highlight Once you have marked out your image and have either
areas that you want kept intact and untouched during selected areas to protect and areas to remove, you can

the scaling process. Similarly, you can also make areas that you click and drag on the control points around the perimeter of the
want removed. You can adjust brush Size and Threshold and image. In this case, we are going to drag the right middle control
any scaling restrictions you wish to apply. point inwards.

You can begin to drag the control point inwards and as The control point can be dragged all the way across the
you do, all the areas that are unprotected will concertina image. All the dirt and dust on the right of the image has

together and the program will attempt to blend that pixel data been merged into the space that remains now the image is half
together. The areas that are selected to be protected will not be the width it was originally, but the car is unchanged.
crushed together.

Content Aware Move Tool

the Content Aware Move Tool (Q) uses similar technology The options panel gives you some simple tool parameters.
to the Recompose Tool but in this case it lets you move You will need to draw a selection around the object in

an object in your photo and place it elsewhere in the shot and the photo you wish to move. You can add or subtract from the
blends it back in and fills the original gap left by the subject. selection you've made by using the New, Add, Subtract and

Intersect options provided.
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MODIFY, CROP AND RECOMPOSE

With the tool active, you can draw around the subject Oo
Enclose your subject in a selection and then drag it to its

that is going to be moved. Be aware that areas with new location. The Healing slider controls how aggressively
complex content can be a challenge and the area you move it tries to blend the image into the new location and also fill the
your subject to needs to be of a similar texture and colour for it gap it leaves behind. Tne Mode can be altered from Move to
to work properly. Extend to stretch your selection if required.

The Content Aware Move Tooi will blend the image We tried the sailboat image and also a simple object on
together. It can be a hit and miss process and may require grass. The grass image yielded better results after a few

the settings to be tweaked. You can also try selecting more of attempts but it still needed some cleaning up with the Clone
the area around your subject for more blend data to be used. Stamp Tool to remove some obvious artefacts and blend in some

untouched grass.

hten Tool

The Straighten Tool (P) will easily take care of wonky Simply click and draw along a slanted horizon line that
landscape photos and get them level again. You have a needs to be level. When you let go of the button the

number of options as to how the image is handled once horizon will be levelled. There is an option to Autofill Edges.
straightened. The canvas can grow as required when rotated, When the image is rotated, any blank areas will be filled with
stay the same size or be cropped to remove the background. nearby similar textures.
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